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6 Reasons Why Your VLOOKUP is Not Working
by Alan Murray Excel, Excel functions, Excel tips, Excel Vlookup 24 Comments

The VLOOKUP function is the most popular lookup and reference function in Excel. It is also one of the
trickiest and the dreaded #N/A error message can be a common sight.

This article will look at the 6 most common reasons why your VLOOKUP is not working.

You Need an Exact Match
The last argument of the VLOOKUP function, known as range_lookup, asks if you would like an
approximate or an exact match.

In most cases people are looking for a particular product, order, employee or customer and
therefore require an exact match. When looking for a unique value, FALSE should be entered for
the range_lookup argument.

This argument is optional, but if left empty, the TRUE value is used. The TRUE value relies on your
data being sorted in ascending order to work.

The image below shows a VLOOKUP with the range_lookup argument omitted, and the incorrect
value being returned.

Solution

If looking for a unique value, enter FALSE for the last argument. The VLOOKUP above should be
entered as =VLOOKUP(H3,B3:F11,2,FALSE).

Lock the Table Reference

You Need an Exact Match1.

Lock the Table Reference2.

A Column Has Been Inserted3.

The Table has got Bigger4.

VLOOKUP Cannot Look to its Left5.

Your Table Contains Duplicates6.
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Maybe you are looking to use multiple VLOOKUPs to return diÖerent information about a record.
If you are planning to copy your VLOOKUP to multiple cells, you will need to lock your table.

The image below shows a VLOOKUP entered incorrectly. The wrong cell ranges are being
referenced for the lookup_value and table array.

Solution

The table that the VLOOKUP function uses to look for and return information from is known as the
table_array. This will need to be referenced absolutely to copy your VLOOKUP.

Click on the references within the formula and press the F4 key on the keyboard to change the
reference from relative to absolute. The formula should be entered as
=VLOOKUP($H$3,$B$3:$F$11,4,FALSE).

In this example both the lookup_value and table_array references were made absolute. Typically it
may be just the table_array that needs locking.

A Column Has Been Inserted
The column index number, or col_index_num, is used by the VLOOKUP function to enter what
information to return about a record.

Because this is entered as an index number, it is not very durable. If a new column is inserted into
the table, it could stop your VLOOKUP from working. The image below shows such a scenario.

The quantity was in column 3, but after a new column was inserted it became column 4. However
the VLOOKUP has not automatically updated.

Solution 1

One solution might be to protect the worksheet so that users cannot insert columns. If users will
need to be able to do this, then it is not a viable solution.

Solution 2

Another option would be to insert the MATCH function into the col_index_num argument of
VLOOKUP.

The MATCH function can be used to look for and return the required column number. This makes

the col_index_num dynamic so inserted columns will no longer aÖect the VLOOKUP.

The formula below could be entered in this example to prevent the pUltimate Suite for Excel Professionals
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above.

The Table has got Bigger
As more rows are added to the table, the VLOOKUP may need to be updated to ensure that these
extra rows are included. The image below shows a VLOOKUP that does not check the entire table
for the item of fruit.

Solution

Consider formatting the range as a table (Excel 2007+), or as a dynamic range name. These
techniques will ensure that your VLOOKUP function will always be checking the entire table.

To format the range as a table, select the range of cells you want to use for the table_array and
click Home > Format as Table and select a style from the gallery. Click the Design tab under Table
Tools and change the table name in the box provided.

The VLOOKUP below shows a table named FruitList being used.

VLOOKUP Cannot Look to its Left
A limitation of the VLOOKUP function is that it cannot look to its left. It will look down the leftmost
column of a table and return information from the right.

Solution

The solution to this involves not using VLOOKUP at all. Using a combination of the INDEX and
MATCH functions of Excel is a common alternative to VLOOKUP. It is far more versatile.

The example below shows it being used to return information to the left of the column you are
looking in.

Learn more about using INDEX and MATCH
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Your Table Contains Duplicates
The VLOOKUP function can only return one record. It will return the Ñrst record that matches the
value you looked for.

If your table contains duplicates then VLOOKUP will not be up to the task.

Solution 1

Should your list have duplicates? If not consider removing them. A quick way to do this is to select
the table and click the Removes Duplicates button on the Data tab.

Check out the AbleBits Duplicate Remover for a more complete tool for handling duplicates in
your Excel tables.

Solution 2

Ok, so your list should have duplicates. In this case a VLOOKUP is not what you need. A PivotTable
would be perfect to select a value and list the results instead.

The table below is a list of orders. Let's say you want to return all the orders for a particular fruit.

A PivotTable has been used to enable a user to select a Fruit ID from the report Ñlter and a list of
all the orders appears.

Ultimate Suite for Excel Professionals

6 Reasons Why Your VLOOKUP is Not Working https://www.ablebits.com/office-addins-blog/2014/04/09/why-excel-v...

4 of 9 ق.ظ 08:53 2015/09/21



Please follow us on Google+:

Want to Ñnd more inventive tips, tricks and tutorials?
1.6k

24 Responses to "6 Reasons Why Your VLOOKUP is Not
Working"

Trouble Free VLOOKUPs
This article demonstrated a solution to the 6 most common reasons a VLOOKUP function is not
working. Armed with this information you should enjoy a less troublesome future with this
awesome Excel function.

About the Author
Alan Murray is an IT Trainer and the founder of Computergaga. He oÖers online training and the
latest tips and tricks in Excel, Word, PowerPoint and Project.

Sripathi Uday Kumar says:
August 12, 2014 at 10:05 am

Thank you, it was helpful.

Reply
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Daniel says:
October 23, 2014 at 10:06 am

The trapfall of VLOOKUP being not able to "look to right" wasn't known to me before. Very hel
pful!
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shahram says:
November 10, 2014 at 7:17 pm

Thank you, it was helpful.
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anil says:
December 2, 2014 at 4:25 am

when we using vlookup it is show is same number in all colons
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Dan says:
January 9, 2015 at 10:18 am

Sometimes the error may be because it has not calculated properly. If you have calculation se
t to manual rather than automatic, this can also cause an error when using vlookup or index
match. Once the worksheet calculation is set to automatic, it works again (set it to automatic b
y going to the Formulas tab and then Calculation Operations and set to Automatic).

Reply

Joe says:
February 10, 2015 at 2:26 pm

Dan,

THANK YOU!!! Hours wasted, but many more hours saved. The Automatic setting in Calcul
ation Operations did it. Karma credits in the heapful submitted your way.

Reply

Preeti says:
June 4, 2015 at 8:08 am

Thank u Dan.
I was trying to copy formula and wasted hours. ur just one line comment solved my pro
blem in a tick
:)
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Silvina says:
January 14, 2015 at 11:12 am

Thanks a lot! very helpful :)
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Oskar says:
January 26, 2015 at 1:01 am

thanks a lot for this information
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Brian says:
April 7, 2015 at 4:27 pm

Hopefully someone can help me. My vlookup is returning the correct values in my columns b
ut it returns the same value until it comes across another non-zero value. For example the co
rrect value of row 10 is 259 but it will return 259 for rows 11, 12, and 13. Row 14 will correctly s
how 864 but then rows 15 and 16 will too.

Has anyone come across this?

thanks,

Reply

8

Alan Murray says:
April 8, 2015 at 10:48 am

Hard to say why without seeing the spreadsheet but would expect there to be an error in the l
ookup value argument. I would check the reference.
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Ahmed says:
May 18, 2015 at 8:35 am

thank you

10
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Reply

Andy says:
May 25, 2015 at 3:44 am

Hi Don,

Having calculation set from manual to automatic is very helpful. Save lots of time.

Thank you very much.

Andy
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Tu N says:
June 17, 2015 at 8:56 pm

Thank you, thank you, thank you for the manual - automatic guide.
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K.Mahedner reddy says:
July 20, 2015 at 9:49 pm

can any help me put

i had a sheet of name of the employs and their working hours, here the problem is in my she
et i had two names similar...(EX: mahesh as two time in the sheet )

when i use vlookup in the table for my sheet i am not getting the second name

how can i get the second name in the sheet........by using vlookup
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Alan Murray says:
July 21, 2015 at 7:18 am

VLOOKUP won't be able to. It will only return the Ñrst name from the sheet.

You will need more than 1 VLOOKUP. Or a macro would be needed for multiple occurrances
of a name.
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Harshad says:
July 23, 2015 at 6:01 am

Thanks for sharing. I had some hidden columns so my VLOOKUP was not working! Fixed it aft
er readong Point 3. on your list.
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Kate says:
August 5, 2015 at 4:24 pm

i am doing a very simple lookup and I am getting the #n/a. Trying to pull a number into my m
aster. The Ñrst column on both is my ref. the formula is =vlookup(A2,PLANC,2,false). Very very
simple. I checked to make sure there was a match and there was and no duplicates were foun
d. Help!

Reply

16

Alan Murray says:
August 5, 2015 at 8:49 pm

Hard to say exactly without seeing the Ñle. Check that there is deÑnitely a match, so no spaces
after the number. And also check the formatting of both the lookup_value and on the table_a
rray to check they are the same.
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Mark W says:
August 10, 2015 at 9:34 pm

I am trying to write a VLookup formula to bring on hand data into a sheet that details sales vo
lume. My formula is:: =VLOOKUP(A2,AA$2:AB$100,2,FALSE)
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Item B1007080SHF3MDO2BS***GG is not present on the target range; Item B1007080SHF3M
DO2BSR**GG is there, with a required response value of 409.

When I apply the VLookup to both Ñelds, I get the value of 409 for BOTH, so the 'exact value' p
art of the formuala does not seem to be working. I have both lists sorted A-Z. It does not see
m to matter if I format both columns as text or numbers, same issue (the full data set column
does have values that are numbers only & alpha-numeric in both the search criteria and the t
arget range).
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Alan Murray says:
August 11, 2015 at 7:34 am

It looks like the VLOOKUP is using the ** characters as a wildcard.
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Mark W says:
August 11, 2015 at 1:23 pm

That might be. My ERP system only allows * as special characters so all my item number data
exports have * in them. Do you know of a way to prevent this?
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Alan Murray says:
August 11, 2015 at 1:54 pm

You might be able to concatenate a string. Wrap the * in "" to indicate that you want to refer t
o that character literally and not as a wildcard.

Otherwise you might be able to use the EXACT function with INDEX and MATCH instead of VLO
OKUP. Information on this can be found below.

http://www.computergaga.com/tips/lookup_formulas/case_sensitive_lookup.html

I have not tested this, but think it should work. This function does what its name suggest and
ensure the strings match.
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Belinda says:
August 31, 2015 at 6:18 pm

Watched the YouTube video and it was brilliant instruction!

Saved me loads of time and frustration.

Thanks so much.
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